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1. Interfaz grafica de SAGA GIS

Semana 7

Si ejecutamos la interfaz grafica de SAGA GIS (denominada saga gui, ejecutable: saga_gui.exe), se

abrird el programa, con un aspecto similar al siguiente:

|& sacasz0 - u
File Geoprocessing Window ?
SDEEOR0 % 0
Manager x || Properties x
© Data O Description
& Maps 4 Settings
1A Tool Librari A
330 Climate ¢
Hé. Garden Tip of the Day
@ Grid
11 Grid Coll 0
b ot ! Did you know...
(1@ Import/E that you can resize the Manager,
5 Projectio Messages and Properties windows by
11 ® Reports grabbing the border of the window?
@ Shapes v
<H >
Data Sources  x
% ODBC
% PostgreSQL
[ File System
= Sistema (C) Mshowtipsatstartup | NextTip | Close
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© General ® Execution © Errors
||—2023-10-06II 1:50:58] Loading tool chain: CAU: EMetiD 2.0, TravefTime xml.. okay ~
, @
Recognized Fi VI v
ready

La aplicacién abre por defecto 4 diferentes paneles que se pueden recolocar, redimensionar o sacar
de la visualizacidn segln nuestras necesidades.
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En la parte superior se encuentra el menu de opciones y la barra de herramientas rapida, con el
siguiente aspecto por defecto.

& SAGA 920 — o X

Properties x
(4 settings @ Description

B\ ODBC €& PostgreSQ
[ File System
- Sistema (C)

Show Manager Window
Show Object Properties Window
Show Data Source Window

mulation
Spatial and Geostatistics
N

Table

Spatial and Geostatistics
TIN
Table

rrain Analysis
@ Tool Chains
@ Visualization

lessages Terrain Analysis

Load Tool Library Show Message Window
Open
Find and Run Tool
. Cascade
Project >
Climate and Weather ¥ Tile Horizentally
Table b
Database > Tile Vertically
Shapes b
. File > Arrange lcons
Point Cloud b
Garden > x
TN » Next -
. Grid > )
Grid » Previous
R . Grid Collection »
Grid Collection ¥ Close
. r=gay, 4 Close All
Projection > = @ Import/Export
=@ Projection
Shapes > ¢ Re;ons
Simulation ¥ @ shapes
-3
-]
*
b
>

O General @ Exccution
tta_TravelTime al..okay ~

[2023-10-06/11:50:58] Lo Visualization
Recognized Files - :

ready

Las opciones se iran modificando segln lo que estemos trabajando en cada momento. En general,
en File encontramos las opciones de abrir capas, abrir y guardar proyectos, etc. En Geoprocessing,
encontraremos lo mdédulos clasificados por tematicas. Y en Window se gestiona la visualizacién de
las ventanas.

A partir de aqui veremos diversos ejemplos donde profundizaremos en las distintas secciones, con

la finalidad de proporcionar soltura con el manejo del programa.

2. Anadiendo capas a un proyecto

Ejercicio 1. Representar en un mapa las siguientes capas:

a) CNTR_RG_01M_2020_4326.shp

Se trata de una capa shp de poligonos que representa a los paises del mundo. Se ha descargado de
EUROSTAT: https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-
units/countries

-> File > Shapes = Load.

Podemos comprobar que al afiadir la capa, ésta no se e Toos| & 0os @ hage *
representa automaticamente de forma grafica en el :;Tum 88 Thumbnals

area de visualizacion. o

Si vamos a la ventana Manager = pestaiia Data, &3 1. CNTRRG_0IM_2020 4326

aparece la capa que acabamos de cargar. En esta = =

pestafia se mostrardn todos los objetos cargados en | * Toos & Data @ Mags
[ Tree 88 Thumbnails

el proyecto; i
En la pestaiia Maps vemos que no aparece nada. En “() <noitems>
esta pestaia se gestionan los mapas a representar.
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Para visualizar una capa en SAGA GIS necesitamos afiadirla a un mapa. Para ello se puede por
ejemplo, clicar sobre la capa a visualizar (en Manager = Data) y en el menu desplegable de
pulsar el botdon derecho, clicar en: Add to Map. O simplemente hacer doble clic (en Data)
sobre la capa a representar en el mapa.

Cambiamos el nombre de la capa a: PaisesMundo

Fill Style: Transparent

Cambiamos el nombre del mapa a Precipitacion Mundial
Guardamos proyecto: Ejerciciol

A 2R 20 20 4

b) CNTR_BN_01IM_2020_4326_COASTL.shp
Se trata de una capa shp de lineas que representa las lineas costeras mundiales. Obtenido de
EUROSTAT: https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-
units/countries
- File = Shapes = Load.
- Lo visualizamos en el mismo mapa de antes: Precipitacion Mundial
- Cambiamos su nombre a: LineasCosta

c) Stationsl.shp
Es una capa shp de puntos, con informacidn sobre estaciones meteoroldgicas que constan en la base
de la WMO. Fueron «creada por Hijmans et al, y se puede obtener en
https://databasin.org/datasets/15a31dec689b4c958ee491ff30fcce75/

- File = Shapes = Load.

- Lo visualizamos en el mismo mapa de antes: Precipitacion Mundial
- Cambiamos su nombre a: WMO_stations

> Color de los puntos: Single Symbol: RGB(0,128,0)

- Tamano de los puntos: 2

d) chirps-v2.0.2022.tif
Capa raster (50S-50N) de precipitacion acumulada anual en 2022 en mm. (Fuente de datos CHIRPS 2.0:
https://data.chc.ucsb.edu/products/CHIRPS-2.0/)
-> File 2 Grid 2 Load.
- Cambiamos su nombre a: Precipitacion Anual 2022 (mm)
> Aplicamos la paleta de colores del fichero: Tabla_Panual.txt
- Guardamos una imagen del mapa con su leyenda.
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3. Seleccién y recorte de capas

Ejercicio 2. Representar en un mapa el modelo digital de elevaciones de Colombia.
e Abrimos proyecto nuevo: File = Project 2 New Project

e Cargamos en el proyecto la capa CNTR_RG_01M_2020 _4326.shp.
(capa shp de poligonos que representa a los paises del mundo.

EUROSTAT: https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-

units/countries)
o File = Shapes = Load.

o Cambiamos su nombre a: PaisesMundo
o Cambiamos el nombre del mapa a Colombia
o Guardamos proyecto: Ejercicio2

e A partir de la capa anterior de PaisesMundo, creamos una capa con solo el poligono que

representa a Colombia.
Una de las maneras posibles de obtener esto, seria:

o usar la herramienta de seleccic’)n, y seleccionar el poligono deseado.

o Geoprocessing = Shapes = Selection = Copy Selection to New Shapes Layer


https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-units/countries
https://ec.europa.eu/eurostat/web/gisco/geodata/reference-data/administrative-units-statistical-units/countries
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@ Copy Selection te New Shapes Layer X
F Data Objects Oy
= Shapes
>> Input 1. PaisesMundo Cancel
<< Qutput <create> ~
Load
Save
Defaults
<< Qutput

shapes, output
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o Cambiamos el nombre de la capa creada a partir de la seleccion a Colombia.
o Cambiamos el color de relleno de poligono a “Green”.

e Cargamos en el proyecto la capa raster: W100N40.DEM
Modelo digital de elevaciones global, GTOPO30, de espaciado horizontal de rejilla de 30 segundos
de arco. Proyecto colaborativo liderado por el USGS. Descargado de: http://www.webgis.com/terr_world.html

o Geoprocessing = File 2 Grid 2 Import Raster

& Import Raster x
= Options Okay
"\Ejercicio2\w100n40\W100N40.DEM"
Multiple Bands Output automatic Cancel
Select from Multiple Bands 0
= Transformation
Resampling Nearest Neighbour Load
Extent original
Save
Defaults
Files
file path Info >>

GTOPO30Q tiles
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https://www.usgs.gov/centers/eros/science/usgs-eros-archive-digital-elevation-global-30-arc-second-elevation-gtopo30
http://www.webgis.com/terr_world.html
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o Mostramos en el mapa solo la capa de poligonos de Colombia (por encima,
tranparente y color outline: Silver, size 2), y el DEM. Eliminamos del mapa
PaisesMundo.

e Recortamos el grid del MDE (W100N40.DEM) segun el poligono de Colombia
anteriormente creado.
o Se usa para ello el modulo “Clip Grid with Polygon”:
Geoprocessing = Shapes = Shapes-Grid-Tools = Spatial Extent = Clip Grid with
Polygon

& Clip Grid with Polygon X

S Data Objects
£l Grids
= Grid System 0.008333; 4800x 6000y; -99.995833x -9.995833y Cancel

>> Input
© Shapes
>»> Polygons
© Options
Target Extent

1 object (W100N40)

2. Colombia

polygons

>> Polygons
shapes, input

o Automdticamente se crea una capar raster con una extension menor que el DEM

anterior, correspondiente a la zona de Colombia.
Lo renombramos a DEM_Colombia.

e Aplicamos a DEM_Colombia una paleta de 11 colores segun la tabla de valores siguiente:

DESCRIPTION R G B HEX
“Mar”_(0-0.000001) 140 198 255 #8CCOFF | |
"0 - 200" 112 153 89 #709959
"200 - 400" 169 191 120 #a9bf78
"400 - 600" 231 232 155 #e7e89b
"600 - 800" 242 229 153 #f2e599
"800 - 1000" 242 213 141 #f2d58d
1000 - 2000" 230 187 131 #e6bb83
"2000 - 3000" 209 159 130 #1982
"3000 - 4000" 201 147 137 #c99389
"4000 - 5000" 230 190 201 #ebbec9
">5000" 255 242 255 HF2ff

o Guardamos la tabla de colores como “Colores_Altitud.txt”

o En capa Shape Colombia: outline black, size 1



Curso PIB-M

Manejo Basico de SAGA GIS Semana 7
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4. Mosaicking de capas raster

Ejercicio 2b. Representar en un mapa el modelo digital de elevaciones de Australia.

Se trata de repetir el Ejercicio 2, pero esta vez con Australia. Para ello, si nos fijamos en las tiles

del GTOPO30, vemos que se necesitan dos grid de DEM para formar Australia. Veremos como

hacerlo usando la herramienta “Mosaicking”.

e Borramos todas las capas del proyecto salvo “PaisesMundo” y guardamos en proyecto
nuevo:”Ejercicio2b”.

e Descargamos de http://www.webgis.com/terr _world.html las capas GTOPO30
correspondientes a Australia: E100S10y E140S510.

e Cargamos en SAGA mediante la herramienta “Import Raster” las capas “.DEM” asociadas.

e Representamos ambas capas en el mismo mapa, que renombramos a “Australia”.
e Vemos que los DEM representan la zona pero son 2 capas separadas, procedemos a unirlas
mediante la herramienta “Mosaicking”:
o Geoprocessing = Grid = Grid System = Mosaicking
= En Grids se seleccionan los grids a unir.
=  Name: ZonaAustralia


http://www.webgis.com/terr_world.html
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& Mosaicking

| Data Objects
= Grids
> Grids
O Options
Name
Data Storage Type
Resampling
Overlapping Areas
Match
=) Target Grid System
Cellsize
West
East
South
North
Columns
Rows
Fit

X
2 cbjects (E100510, E140510) Cancel
Australia
same as first grid in list Load

B-Spline Interpolation

last

none

user defined

0.0083333333

100.0041666667 Info »>
179.9338330134

-59.9958333333

-10.0041668666

9600
6000

nodes

Save

Defaults

Semana 7

e Eliminamos del mapa la visualizacién de las capas E140S10 y E100S10, dejando solo

ZonaAustralia y PaisesMundo.

e Recortamos ZonaAustralia segin el

poligono correspondiente a Australia segun

PaisesMundo. En esta ocasion en vez de usar la herramienta de seleccion , usaremos la

herramienta “Select by Attributes... (String Expression)”.

o Geoprocessing = Shapes = Selection = Select by Attributes...

= Data Objects
= Shapes
I=I = > Shapes

Attribute

= Options
Expression
Case Sensitive
Select if...
Method

@ Select by Attributes... (String Expression)

1. PaisesMundc
CNTR_MAME

Australia

O

attribute contains search expression

new selection

*

Cancel

Load
Save

Defaults

Info =>

(String Expression)

o Geoprocessing = Shapes = Selection = “Copy Selection to New Shapes Layer”, la
renombramos a Australia (la visualizamos en mapa de Australia, Color: Green)
o Recortamos mediante “Clip Grid with Polygon”

& Clip Grid with Polygen

= Data Objects
= Grids
I=| Grid System
»> Input
= Shapes
>> Polygons
= Options
Target Extent

Okay
0.008333; 9600x 6000y; 100.004167x -59.995833y Cancel
1 object (ZonaAustralia)
3. Australia Load
Save
polygons
Defaults

o Larenombramos a DEM_Australia y la visualizamos en el mapa con los colores de Ia

tabla “Colores_Altitud.txt” creada en el Ejercicio2.
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5. Conversion de tabla de datos a capa de puntos

Ejercicio 3. Representar los valores de precipitacién mensual y anual de Colombia que se
encuentran el fichero de texto: “Datos_PREC_Colombia_1961-1990.txt” en una capa shape de
puntos. Se representara en el proyecto del Ejercicio2 (esto es, con el MDE_Colombiay las lineas
limites del pais).

Los datos recogidos en el anterior fichero, son recopilados de los valores climaticos normales
alojados en la NOOA: WMO Climate Normals (noaa.gov)

e Abrimos el proyecto del ejercicio2, lo guardamos como Ejercicio3 y cargamos
“Datos_PREC_Colombia_1961-1990.txt".
o File > Table - Load
e Convertimos la Tabla a capa de puntos mediante el médulo: “Convert Table to Points”
o Geoprocessing = Shapes = Conversion = Convert Table to Points

& Convert Table to Points X
R
<< Points. <create>
5 Tables
£l »» Table 1. Datos_PREC_Colombia_1961-1990
Y LAT
Savi

e Representar esta capa en el mapa conjunto.
o Asignar color “Blue” a los puntos
o Tamafo del punto: 4
o Etiqueta a mostrar: precipitacién anual (P13)
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6. Ejemplos de operaciones con rejillas

Ejercicio 4. A partir de las rejillas de precipitacion total mensuales globales de 2022, obtener una
rejilla de precipitacion total anual de 2022 para Colombia.
e Partimos del proyecto del ejercicio 2 (DEM y poligono de Colombia). Lo guardamos como
Ejercicio4.
e Cargamos las 12 capas chirps de 2022: “chirps-v2.0.2022.01.tif’,“chirps-

v2.0.2022.02.tif", etc. (Fuente de datos CHIRPS 2.0: https://data.chc.ucsbh.edu/products/CHIRPS-
2.0/)
o File > Grid - Load (cargamos las 12 capas a la vez)

e Como son rejillas casi-globales, procedemos a recortarlas segun el poligono de
Colombia. Para ello usamos el médulo: “Clip Grid with Polygon”:
o Geoprocessing = Shapes = Shapes-Grid-Tools = Spatial Extent = Clip Grid with
Polygon

& Clip Grid with Polygen

*

B Data Objects Okay
= Grids
=l Grid System 0.050000; 7200x 2000y; -179.975000x -49.975001y Cancel
12 objects (chirps-v2.0.2022.01, chirps-v2.0.2022.02, chirps-v2.0.2022.03 . |
=l Shapes
>> Polygons 2. Colombia oa
& Options
Target Extent polygons <

Defaults

Info >>

H
a

o Asignamos a la primera capa (enero) los colores segun la tabla: “Tabla_Panual.txt”.
Copiamos esta caracteristica a las demds capas (de la 2 ala 12), desde la pestana Data
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- seleccionamos todas estas capas (de la 2 a la 12) = botdn derecho = “Copy
Settings” = copiamos de la capa 1.
o Representamos todas las capas a la vez en el mapa, seleccionandolas todas = botén
derecho - Show.
e Calculamos la rejilla de precipitacion total de 2022, aplicando el médulo: “Grids Sum”
o Geoprocessing =2 Grid = Calculus = Grids Sum

@& Grids Sum
© Data Objects
= Grids
= Grid System 0.050000; 298x 351y; -81.724999x -4.175001y
>3> Grids 12 objects (chirps-v2.0.2022.01, chirps-v2.0.2022.02, chirps-v2.0.2022.03, chirps-v2.0.; -
<< Sum <create>
© Options
Count No Data as Zero O

o Cambiamos el nombre de la capa generada a PREC_anual_2022 y copiamos las
propiedades de la del mes de enero. Finalmente se representa en el mapa.

-86 -85 -3‘4 -83 -82 -81 -S‘O -79 -78 -7 -76 -75 -74 -73 -2 - -70 69 -68 67 -66 —6‘5 64 -5‘3 62

2 ) Precipftacién ‘Anual 2022 2

ey

o ;// o
P,

Precipitacion (mm)

i >7000
=1 5000-7000

T T T T i
-66 65 64 63 -62

Ejercicio 5. A partir de las rejillas de temperatura media mensual de 2022 (K), obtener la rejilla de
temperatura media anual de 2022 para Colombia y aplicarle la paleta de colores almacenada en
“Tabla_T.txt” (°C).
e Partimos del proyecto del ejercicio 2 (DEM y poligono de Colombia). Lo guardamos como
Ejercicio5.
e Cargamos las 12 capas de temperatura media ERAS de 2022: “TT_2022-01.tif”, “TT_2022-
01.tif", etc. (Fuente de datos: rejillas de 0.12 x 0.12, Temperatura media (K): ERA5-Land monthly

averaged data)
o File 2 Grid = Load (cargamos las 12 capas a la vez)
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o Representamos en el mapa por ejemplo TT_2022-01.tif.

e Recortamos las capas segun el poligono de Colombia. Para ello usamos el médulo: “Clip
Grid with Polygon”:
o Geoprocessing = Shapes = Shapes-Grid-Tools = Spatial Extent = Clip Grid

with Polygon
& Clip Grid with Polygon X
El Data Objects Okay
[ Grids
I=| Grid System 0.1; 301x 251y -90x - 10y Cancel
12 objects (TT_2022-01, TT_2022-02, TT_2022-03, TT_2022-04, TT_2022-05, TT_2022-06, TT_2022-(/ ..
= Shapes
= Polygens 2. Colombia Load
El Options
Save
Target Extent polygons
Defaults

e A partir de estas 12 rejillas, calculamos la rejilla media, que proporcionara la temperatura
media anual de 2022, para ello usaremos por un lado el mdédulo “Grids Sum”, para
obtener el grid suma de todos los meses; y por otro el médulo “Grid Calculator” para
dividir entre el nimero de meses y obtener asi la media.

o Geoprocessing = Grid = Calculus 2 Grids Sum

& Grids Sum X
= Data Objects Okay
= Grids
I Grid System 0.1; 121x 166y; -78.9x -4.1y Cancel
12 objects (TT_2022-01, TT_2022-02, TT_2022-03, TT_2022-04, TT_2022-05, TT_20| -
<< 5um <create>
= Options Load
Count No Data as Zero O
Save
Defaults
o Geoprocessing = Grid = Calculus = Grid Calculator
& Grid Calculator X
= Data Objects Okay
=l Grids
= Grid System 0.1; 121x 166y; -78.9% -4.1y Cancel
> Grids 1 object (Sum)
<< Result <create>
= Grids from different Systems Mo objects Load
= Options
Save
Formula gl /12
Take Formula O
Use No-Data O
Data Type 4 byte floating point number Info »>

o Lacapa creada se denomina TT_2022.
e Ahora debemos aplicar la paleta de colores almacenada en “Tabla_T.txt”. Las unidades
de esta paleta son 2C, y las unidades de la rejilla de temperatura anual, son Kelvin. Vamos
a convertir los valores de la rejilla a 2C, mediante la calculadora grid.
o Geoprocessing = Grid = Calculus = Grid Calculator

13
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& Grid Calculator .
BN
= Grids
1= Grid System 0.1; 121x 166y; -78.9x -4.1y
= Grids 1 object (TT_2022)
BT -
» Grids from different Systems No objects
= Options
Saw
Formula gl-273.15
= Name TT_2022_en°C
Take Formula O
Use No-Data O
Data Type 4 byte floating point number

e A esta capa resultante: “TT_2022 en9C” le asignamos

“Tabla_T.txt”.

los colores de la tabla:

-86 —8‘5 —§4 —3’3 -3‘2 —SI1 -B‘O -79

-76 -75 -74 -73 -2 -70 -6'9 —6‘8 —6]

G . .

| Temperatura (°C)

. 30

<] . 25 a 30
. 26 a 28
B 24a26
- [ 22a24
[ J20a22
. l18a20
o 16a18
[ J14a16
0 12a14
7 £ 10a12
B 5a 10

o Terhpe}'attllra Media Anual 2022

13

12

1

10

9

8

7

6

5

4

3

2

66 65 64 63 62

7. Resampling

Ejercicio 6. Redimensionar la capa de precipitacion total anual de 2022 al tamaio de celda de la

temperatura media de 2022 (generadas respectivamente en los ejercicios 4 y 5).

e Cargar la capa de precipitacion total anual del ejercicio 4 en el proyecto Ejercicio5 y

guardarlo como Ejercicio6.

e Podemos comprobar que las dimensiones de las celdas de ambas capas son diferentes:
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Manager
% Tools & Data @ Maps
[ Tree BR Thumbnails

i Data
NG
Bl 0.002333; 1798x 2114y; -81,854167x -4,220833y
: B 1. MDE_Colombia

- - )

IED 0.050000; 298x 351y; -81,72409 -4.175001y
B 13, PREC_2022

0.1; 121 166y; - 78.9x -1y

B& Shapes
=43 Polygon
&} 1. PaisesMundo

En este caso nos piden redimensionar la capa de precipitacién a la de temperatura,
disminuir su resolucién. Podemos usar una herramienta para este fin: “Resampling”.
o Geoprocessing = Grid = Grid System > Resampling

& Resampling X
= Data Objects Okay
= Grids
I=I Grid System 0.050000; 298x 351y; -81.724999x -4.175001y Cancel
>> Grids 1 object (PREC_2022)
= Options
Preserve Data Type O Load
Mean Value (cell area weighted) ~ o
1= Target Grid System grid or grid system
Grid System 0.1; 121x 166y; -78.9x -4.1y Defaults

o Podemos comprobar que se ha creado una nueva capa en el cojunto de grids de
tamafio de celda 0.1.

o Copiamos los settings de la capa original de precipitacion y la representamos en
el mapa.

8. Anadir valores de grid a capa de puntos

Ejercicio 7. A partir de las capas de temperatura y precipitacion redimensionadas del ejercicio
anterior, asignar sus valores en los puntos de la capa stationsl.shp (cuyos puntos son las
estaciones de la base de datos de la WMO) solo para la zona de Colombia.

e Partimos del proyecto del Ejercicio6, donde debemos tener las capas redimensionadas
de precipitacién y temperatura y el poligono correspondiente a Colombia. Lo guardamos
como Ejercicio?.

e Cargamos la capa de puntos “stations1.shp”.

e Comprobamos que son estaciones a nivel global, pero solo nos interesan las
correspondientes a Colombia. Vamos a seleccionar aquellas que pertenecen solo a
Colombia, y crear una capa nueva de puntos a partir de ésta.

Para seleccionar, hemos visto varias alternativas. Aqui usaremos “Select by Location...”,
gue permite seleccionar en una capa a partir de la extensién de otra. Usaremos la capa
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de poligono de Colombia, y seleccionaremos las estaciones cuyos puntos estén

contenidos dentro.

o Geoprocessing > Shapes = Selection = Select by Location...

6 Select by Location...

= Data Objects
= Shapes
>> Shapes to Select From
>> Locations
E Options
Condition
Method

2. stations1
2. Colombia

have their centroid in

new selection

Okay

Cancel

Load

Save

Defaults

X

o Con la seleccion hecha, creamos una nueva capa: “Copy Selection to New

Shapes Layer”:

& Copy Selection to New Shapes Layer

= Data Objects

shapes, output

Okay

=l Shapes
>> Input 2. stations1 Cancel
<< Output screate>
Load
Save
cETym Defaults

Info >>

o Cambiamos el nombre de la capa de puntos generada a :
estacionesColombia

e Ahora asignamos los valores de las capas de precipitacion y temperatura a esta capa de
puntos, mediante el médulo: “Add Grid Values to Points”
o Geoprocessing = Shapes = Shapes-Grid Tools = Grid Values = Add Grid
Values to Points

& Add Grid Values to Points

) Data Objects

Resampling

B-Spline Interpolation

5 Shapes
=> Points 3. estacionesColombia Cancel
< Result <create>
2 Grids
2 objects (TT_2022_en°C, PREC_2022) Load
El Options

Okay

Save

Defaults

o Cambiamos el nombre de esta capa generada a estacionesColombiaPT.

o Comprobamos su tabla de atributos.
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